Copyright and Disclaimer

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means electronic, mechanical, photocopying, recording, or otherwise without the prior written permission of CyberLink Corporation.

To the extent allowed by law, ColorDirector IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY WARRANTY FOR INFORMATION, SERVICES, OR PRODUCTS PROVIDED THROUGH OR IN CONNECTION WITH ColorDirector AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, EXPECTATION OF PRIVACY, OR NON-INFRINGEMENT. BY USING THIS SOFTWARE, YOU AGREE THAT CYBERLINK WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, OR CONSEQUENTIAL LOSS ARISING FROM THE USE OF THIS SOFTWARE OR MATERIALS CONTAINED EITHER IN THIS PACKAGE.

The terms and conditions here under shall be governed and construed in accordance with the laws of Taiwan.

ColorDirector is a registered trademark along with other company and product names mentioned in this publication, used for identification purposes and remain the exclusive property of their respective owners.

International Headquarters

Mailing Address
CyberLink Corporation
15F., No. 100, Minquan Rd., Xindian Dist.
New Taipei City 231, Taiwan (R.O.C.)

Web Site  http://www.cyberlink.com
Telephone  886-2-8667-1298
Fax  886-2-8667-1300

Copyright © 2013 CyberLink Corporation. All rights reserved.
**Contents**

**Introduction**.................................1

Welcome..................................................................................................................1

Features .................................................................1
DirectorZone .............................................................2
Updating ColorDirector .........................................................2

System Requirements..........................................................3

**Importing Videos**..............................5

Supported File Formats.................................................................5
Importing Videos into the Program..................................................5

**The ColorDirector Workspace**..............7

ColorDirector Modules..................................................................................8

Library .......................................................................................8
Adjustment .................................................................................8
Production ..................................................................................8

Library/Adjustment/Production Panel..................................................8

Library Panel ................................................................................8
Adjustment Panel ......................................................................10
Production Panel ......................................................................10

Keyframe Settings Panel.................................................................10
Storyboard Panel..........................................................................11

Video Viewer Window......................................................................13

Trimming Video Clips ......................................................................13
Detecting Scenes in Video Clips .....................................................14
CyberLink ColorDirector

Splitting Video Clips ......................................................... 16
Selecting Viewer Display Mode ....................................... 16
Selecting View Mode ......................................................... 17
Viewer Zoom .................................................................. 17
Video Player Controls ....................................................... 18
ColorDirector Preferences ............................................... 19
General Preferences ......................................................... 19
Confirmation Preferences .................................................. 20
DirectorZone Preferences .................................................. 21
Hardware Acceleration Preferences .................................... 21
Produce Preferences ......................................................... 22

ColorDirector Projects ......................... 23

Setting Project Aspect Ratio .............................................. 23
Exporting Projects ........................................................... 24

Utilizing Keyframes ................................. 25

Keyframe Timeline ........................................................... 28
Adding Keyframes ............................................................. 31
  Setting Keyframe Behavior ............................................. 32
  Modifying and Removing Keyframes ............................... 33

Making Video Adjustments ............... 35

Converting Videos to Black and White ......................... 36
Regional Adjustment Tools .............................................. 36
  Using a Selection Mask ................................................. 36
  Using a Motion Tracking Mask ........................................ 40
  Using a Gradient Mask .................................................. 45
  Regional Adjustment Options ....................................... 49
Global Adjustment Tools .................................................... 52
  White Balance .............................................................. 52
  Tone .............................................................................. 52
  Hue .............................................................................. 53
Saturation ........................................................................ 54
Lightness .........................................................................................................................54
Black and White ..........................................................................................54
Color Replacement .........................................................................................55

**Using Adjustment Presets..........57**

- Downloading Presets from DirectorZone ........................................57
- Saving Custom Presets ........................................................................58
- Applying Presets on Videos ....................................................................58
- Uploading Presets to DirectorZone ....................................................59
- Exporting/Import Presets ........................................................................59

**Turning Adjustments On/Off........61**

**Production.................................63**

- Producing Video Files .............................................................................63
  - Customizing Profiles ...............................................................................64
  - Configuring Production Options ..........................................................64
- Sharing Videos ..........................................................................................65
  - Uploading Videos to YouTube ..............................................................65

**ColorDirector Hotkeys...............67**

**Technical Support...............71**

- Before Contacting Technical Support ....................................................71
- Web Support ...............................................................................................72
CyberLink ColorDirector
Chapter 1:

Introduction

This chapter introduces CyberLink ColorDirector and provides an overview of all its features. It also outlines the system requirements for installing and using the CyberLink ColorDirector program.

Note: This document is for reference and informational use only. Its content and the corresponding program are subject to change without notice.

Welcome

Welcome to the CyberLink family of digital media tools. CyberLink ColorDirector is a video editing program that turns your video footage into eye-catching movies through the use of video color creating and correcting. You can then render the videos for use in other editing programs or for upload to YouTube.

Features

This section outlines some of the main features of the CyberLink ColorDirector program.

- Trim and split portions out of video clips manually, or use scene detection to auto split scenes based on the original footage.
- Make eye-catching videos instantly by applying presets.
- Adjust video coloring using hue, saturation, and lightness features, or replace a specific color in the video using Color Replacement.
- Color correct video clips by adjusting the white balance, tone, and tinge.
- Make the adjustments on the entire video clip, or use keyframes for full control over the effect timing.
- Apply adjustments on objects that move in video clips using the Motion Tracking Mask.
- Use selection and gradient masks for more precise adjustments on specific areas and frames of your video clips.
- Share produced videos on YouTube, or for use in other programs such as CyberLink PowerDirector.
**DirectorZone**

DirectorZone is a web service that lets you download adjustment presets created by other users, so you can use them on your videos. You may also share your own custom presets by uploading them to DirectorZone.

To access the benefits of DirectorZone, click the **Sign in to DirectorZone** link on the top of the CyberLink ColorDirector window.

Go to http://directorzone.cyberlink.com to view more information on the features and benefits of the DirectorZone web site.

**Updating ColorDirector**

Software upgrades and updates (patches) are periodically available from CyberLink. CyberLink ColorDirector automatically prompts you when either is available.

---

**Note:** you must connect to the Internet to use this feature.

To update your software, do this:

1. Open the Upgrade Information window by doing one of the following:
   - click the button.
   - click on the ColorDirector logo in the top right corner, and then on the Upgrade button in the About ColorDirector window.

2. Click the feature you would like to upgrade to, or the patch you want to update CyberLink ColorDirector with.

3. A web browser window opens, where you can purchase product upgrades or download the latest patch update.
# System Requirements

The system requirements listed below are recommended as minimums for using the CyberLink ColorDirector program.

<table>
<thead>
<tr>
<th>System Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CPU Processor</strong></td>
</tr>
<tr>
<td>Intel Core i3 2nd Gen 2.0 GHz or AMD Phenom II above.</td>
</tr>
<tr>
<td><strong>Screen Resolution</strong></td>
</tr>
<tr>
<td>1024 X 768, 16-bit color or above.</td>
</tr>
<tr>
<td><strong>Operating System</strong></td>
</tr>
<tr>
<td>Microsoft Windows 8.</td>
</tr>
<tr>
<td>Microsoft Windows 7 Home Basic, Home Premium, Professional, Ultimate (32 bit and 64 bit).</td>
</tr>
<tr>
<td>Microsoft Windows Vista Home Basic, Home Premium, Business, Ultimate (32 bit and 64 bit).</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
</tr>
<tr>
<td>1 GB DDR2 required.</td>
</tr>
<tr>
<td>4 GB DDR2 above recommended.</td>
</tr>
<tr>
<td><strong>Graphics Card</strong></td>
</tr>
<tr>
<td>NVIDIA:</td>
</tr>
<tr>
<td>GeForce 8500GT and above</td>
</tr>
<tr>
<td>GeForce 9800GT and above</td>
</tr>
<tr>
<td>GeForce GT/GTS/GTX 200 series</td>
</tr>
<tr>
<td>GeForce GT/GTS/GTX 400 series</td>
</tr>
<tr>
<td>GeForce GT/GTS/GTX 500 series</td>
</tr>
<tr>
<td>AMD/ATI:</td>
</tr>
<tr>
<td>ATI Radeon HD 2600 series</td>
</tr>
<tr>
<td>ATI Radeon HD 2900 series</td>
</tr>
<tr>
<td>ATI Radeon HD 3000 series</td>
</tr>
<tr>
<td>ATI Radeon HD 4000 series</td>
</tr>
<tr>
<td>ATI Radeon HD 5000 series</td>
</tr>
<tr>
<td>AMD Radeon HD 6000 series</td>
</tr>
<tr>
<td><strong>Hard Disk Space</strong></td>
</tr>
<tr>
<td>1 GB of disk space for application and documentation.</td>
</tr>
</tbody>
</table>
CyberLink ColorDirector
Chapter 2:

Importing Videos

The first step when using CyberLink ColorDirector is to import your videos into the program library. You can import videos one by one, or import the entire contents of a folder into CyberLink ColorDirector.

Supported File Formats

CyberLink ColorDirector supports the following video file formats:

**Videos:** AVI, FLV (H.264), M2T (H.264 AVC), MKV (H.264), MOD, MPEG-1, MPEG-2, MPEG-4, TOD, VOB (with Dolby Digital 2ch or 5.1ch), VRO (with Dolby Digital 2ch or 5.1ch), WMV.

CyberLink ColorDirector also supports Canon & Nikon DSLR video files.

Importing Videos into the Program

You can import videos into CyberLink ColorDirector from your computer's hard drive, and from removable devices, such as memory cards and portable hard drives.

To import videos into CyberLink ColorDirector, do this:

1. Click on **Library**, and then on one of the following import options:
   - select to import individual video files. Once selected, browse to and then select all of the videos on your computer/removable device that you want to import, and then click **Open**.
   - select to import a folder that contains your videos. Once selected, browse to and then select the folder on your computer/removable device that you want to import videos from, and then click **Select Folder**.

2. CyberLink ColorDirector imports the video files into the library.

*Note:* you can also drag and drop video files onto the CyberLink ColorDirector window to import them into the program.
CyberLink ColorDirector
Chapter 3:

The ColorDirector Workspace

This chapter outlines the CyberLink ColorDirector workspace, and all of its features. Getting familiar with the workspace is helpful, because it is where you spend all of your time when using CyberLink ColorDirector.

A - ColorDirector Modules, B - Keyframe Settings Panel, C - ColorDirector Preferences, D - Library/Adjustment/Production Panel, E - Storyboard Panel, F - Video Viewer Window
CyberLink ColorDirector

ColorDirector Modules

CyberLink ColorDirector is comprised of three main modules: Library, Adjustment, and Production.

Library

Click the Library button to import video clips into CyberLink ColorDirector and view detailed information video file information. Once imported into the library, you can add them to the storyboard panel for adjusting and editing. See Library Panel for more information.

Adjustment

The Adjustment module is where you touch up and make adjustments to the video clips you imported into CyberLink ColorDirector. Click the Adjustment button to apply presets, use motion track masks and gradients, adjust video saturation, hue, white balance, and much more. See Making Video Adjustments for detailed information.

Production

Once you finish adjusting your video clips, you must render them in the Production module to apply the adjustments you made. All the video clips in the storyboard panel will be rendered into one longer video once produced in the Production module. For more detailed information see Production.

Library/Adjustment/Production Panel

The panel on the left side of the CyberLink ColorDirector window that displays is dependent on which module of the program you are in. The following outlines each of the panels and some of the available features.

Library Panel

The library panel is where you import all of the video clips into CyberLink ColorDirector. It also provides access to the metadata information for each
individual video clip. You can double-click on any video clip in the library to begin playing it in the preview window.

**Importing Videos**

You can import video files individually or by importing all the videos in a specific folder. See [Importing Videos](#) for detailed information.

**Setting Library View**

If required you can change the library view to fit your personal preference. By default the video clips in the library display in thumbnail view, but you can click the button in the top right corner of the library panel to change the view.

Select to view the video clips by file name. Select to view them by their video thumbnails.

**Note:** you can click and drag on the divider between the clips library and video information for a larger view of the clips in the library.

**Video Information**

When you select video clips in the library, CyberLink ColorDirector displays each clip's detailed embedded information in the library panel. Included in the information is video and audio codec information, file size and type, video resolution, frame rate, aspect ratio, and more.
Adding Video Clips to the Storyboard

Once you have video clips in the library, you must add them to the storyboard to make adjustments and edit them on them. You can adjust and produce them one at a time, or add multiple video clips that are merged into a longer video.

To add a video clip to the storyboard, do either of the following:

- drag it from the library to the storyboard.
- select it in the library and then click on its thumbnail.

Adjustment Panel

The adjustment panel displays when in the Adjustment module and contains all of the tools you use to color correct and adjust your videos. See Making Video Adjustments for a detailed description of the all the tools available on the adjustment panel.

Production Panel

When in the Production module, you can set produce preferences in the production panel before rendering your adjusted video clips. See Producing Videos for detailed information about the controls on the production panel.

Keyframe Settings Panel

When in the Adjustment module, click on the Manual tab and then the button to display the keyframe settings panel. Use can use keyframes when adjusting your video clips to define the start and end points of the applied changes.

See Utilizing Keyframes for more detailed information on this feature.
Storyboard Panel

The storyboard panel is where the videos you want to adjust are located.

A - Video Clips, B - Scene Detection

Select a video in the storyboard panel to display it in the video viewer window for playback and adjustment.

Note: all the video clips in the storyboard panel will be rendered into one longer video once produced in the Production window. If you do not want the video clips rendered together, you must add each of them to the storyboard separately, and then adjust and produce them one by one.

While browsing through video clips in the storyboard panel, you can:

- rearrange the order of the video clips in the storyboard panel, just select it in the panel and then drag it to the new position.

- remove a clip from the storyboard panel, right-click on it and then select Remove. You can also remove multiple video clips at once by holding down the Ctrl key on your keyboard, selecting the clips in the panel, and then clicking the button at the top of the video viewer window.

- right-click on a video clip in the storyboard panel and select Open File Location to view the file in Windows Explorer.

- a video clip thumbnail with the icon in the storyboard indicates that adjustments were made on the clip.

- click on the icon in a video clip's thumbnail to detect any scenes that the clip may contain. The detected scenes are added to the storyboard panel like any other video clip. See Detecting Scenes in Video Clips for more detailed
information on this feature.

**Note:** you cannot detect scenes in a video clip that was previously trimmed or split.

- double-click in the video viewer canvas area to hide the storyboard panel from view and get a larger view of the current video (viewer only mode). Double-click on it again to redisplay the storyboard panel (viewer & storyboard mode).
Video Viewer Window

The video viewer window displays a preview of the video selected in the storyboard panel. Any adjustments you make to videos are viewable this window.

Trimming Video Clips

Use the trim function to quickly trim off unwanted portions at the beginning and end of a video clip in the storyboard panel.
To trim a video clip, do this:

**Note**: the trim function is only available when in the Library and Adjustment modules.

1. Select the video clip in the storyboard panel you want to trim, and then click on the button at the top of the video viewer window to open the Trim window.

2. Use the player controls to find where you want the trimmed clip to begin, or the mark in position.

3. Click and drag the mark in and mark out indicators to positions where you want the clips trimmed.

You can also manually set the timecodes for the **Set mark in position** and **Set mark out position** using the up and down arrows as required.

4. Click **OK** to set your changes and trim the clip as specified.

When trimming videos clips, please note:

- use the **Duration** controls if you want to trim the video clip to a specific length.
- to preview what the trimmed clip will look like, ensure **Output** is selected and then click the play button.
- if required, you can reenter the Trim window to refine the trimmed clip at any time.

### Detecting Scenes in Video Clips

The scene detection function automatically detects the individual scenes (or pre-edited shots) contained within a video clip, and then separates them into multiple clips. The detected scenes are added to the storyboard panel like any other video clip.

**Note**: the detected scenes are not split from the original clip, but can be separately moved around or removed from the storyboard panel.

To detect the scenes in a video clip, do this:
Note: you cannot detect scenes in a video clip that was previously trimmed or split. The detect scenes function is only available when in the Library and Adjustment modules.

1. Select a clip it in the storyboard panel and then click the button at the top of the video viewer window to open the Scene Detection window. You can also click the icon on the video clip's thumbnail in the storyboard panel.

2. The scenes in the video clip are automatically detected and then displayed in the Scenes panel.

3. Once you are done detecting the scenes in the video clip, click the OK button. All the separate clips that were detected are now visible in the storyboard panel.

When using scene detection, please note:

- if required, use the Sensitivity slider to increase or decrease scene detection sensitivity. Doing this may yield an increased or decreased number of scenes that are detected. Click to redetect the scenes in the video clip. You are asked to confirm the clearing of the previously detected clips and then the updated scenes are detected and displayed in the Scenes panel.

- click on the button to configure the Advanced Scene Detection Settings. If the selected video clip is a DV-AVI file, you have the option to Detect by change of video frame (used on all other file formats) or Detect by change of timecodes (i.e.: time codes are automatically set when you start and stop recording). Select the Disable preview during detection option to speed up the detection process if you find your computer runs slow during the process.

- to stop the scene detection process before completion, click the stop button on the playback controls.

- to detect scenes manually, drag the slider (in Clip mode) to the beginning of each new scene and then click .

- to preview a detected scene, just select it in the Scenes panel (ensure Scene is selected) and then click the play button.

- to view all the detected scene markers on the clip timeline, ensure that Clip is selected.

- to merge two or more detected scenes into one longer scene, select them in
the Scenes panel and then click **Merge**. Click **Remove All** if you want to restore the clip to the original.

## Splitting Video Clips

You can quickly split a video clip that is in the storyboard panel into two separate clips. To do this, move the timeline slider (or use the player controls) to the position in the clip where you want to split it. Next, click the button to separate it into two clips that you can then move around and adjust separately from one another.

*Note: the split function is only available when in the Library and Adjustment modules.*

You can also use it to quickly remove unwanted portions of a video clip, or if you want to insert other media between the two portions.

## Selecting Viewer Display Mode

The video viewer window has several display modes that let you more easily view the adjustments made to video clips. Click the arrow next in the viewer display mode section to view all of the available display modes.

*Note: these display mode buttons are only available when in the Adjustment module of CyberLink ColorDirector.*

- **Show one** - shows one preview window for the selected video clip in the storyboard panel.
- **Side by side** - select to compare adjustments to videos side by side.
- **Split - left/right** - select to split the video, with the left half containing the original video, and the right half of the video with the adjustments applied.
Top/bottom - select to compare adjustments to videos top to bottom.

Split - top/bottom - select to split the video, with the top half containing the original video, and the bottom half of the video with the adjustments applied.

Selecting View Mode

In the top left of the video viewer window, select one of the following view modes when browsing through and viewing videos in CyberLink ColorDirector:

Viewer & Storyboard Mode - select to display the video viewer window and the storyboard panel for easy browsing and viewing of videos.

Viewer Only Mode - select to display a larger view of the videos.

Note: you can double-click in the video viewer canvas area to hide the storyboard panel from view and get a larger view of the current video (viewer only mode). Double-click on it again to redisplay the storyboard panel (viewer & storyboard mode).

When playing back videos in the program or when making adjustments, select to view the current video at full screen. Once in full screen mode, click to exit.

Viewer Zoom

When previewing videos in the video viewer window, use the zoom drop-down in the top right corner to set the size of the video preview.

Note: you can also hold down the Ctrl key on your keyboard and then use the mouse scroll wheel to zoom in or out on the video viewer window.

Select Fit to resize the selected video so that is fits in the viewer window.

Note: if you find that the size of the video in the video preview window seems quite small when 100% zoom is selected, and becomes distorted after selecting Fit, check that the quality setting of the video is correct. See Playback Options for more information.

When you zoom in or out on a video clip, a navigation thumbnail for the viewer displays in the bottom right of the video frame. Click and drag the available box to change the focus area to suit your zooming requirements.
Video Player Controls

Select a video clip in the storyboard panel and then click the button to begin playing it back. CyberLink ColorDirector will just play back the selected clip when the play button is clicked. If you want to play all the clips in the storyboard, click the button to enter full screen mode, and then click to play the whole movie.

Use the video playback controls available in the video viewer window to control playback, including pausing/stopping playback, fast forwarding videos, jumping to the previous/next frame, or adjusting the volume. You can also click and drag the playback slider to quickly go to a specific timecode in the timecode display, if necessary.

Playback Options

Click the button to access the following playback options:

- **Quality**: select to set the quality of the video in the video viewer window. For best results it is recommended that you set this based on the quality of the original video.

- **Real-time Preview**: select one of the following preview modes:
  - **Real-time Preview**: synchronizes and renders clips and effects in real-time, displaying a preview of your video at the standard 25 (PAL)/30 (NTSC) frames per second.
  - **Non Real-time Preview**: mutes the audio and displays a preview at a reduced speed to help make editing much more fluid. Useful when editing high-definition video on a less powerful computer, or when you receive dropped frames when previewing. By muting the audio and slowing down
the video, CyberLink ColorDirector lets you view more frames per second when your computer has trouble providing a smooth preview during editing.

**Motion Tracking Controls**

The motion tracking controls are available when on the motion tracking mask tab of the Regional Adjustment Tools. They are used when applying regional adjustments on moving objects in videos. See [Using a Motion Tracking Mask](#) for more detailed information.

**ColorDirector Preferences**

To set your program preferences in CyberLink ColorDirector, just click the button or press the Alt+C keys on your keyboard.

**General Preferences**

In the Preferences window, select the **General** tab. The available options are as follows:

**Application:**

- **TV format:** select the TV format (NTSC or PAL) for your video. This format should correspond to the region in which you plan to play your produced video (if you burn it to disc).
- **Drop frame timecode:** if your selected TV format is NTSC, select "Yes" to synchronize the timecode of your video to its video length in the storyboard panel.

**Internet**

- **Automatically check for software updates:** select to periodically check for updates or new versions of ColorDirector automatically.

**Language**

- **Use system default language:** select this option for the language display to be the same as the language of your operating system.
- **User defined:** select this option and then select the language from the drop-
down list that you want to use.

**Confirmation Preferences**

In the Preferences window, select the **Confirmation** tab. The available options are as follows:

**Confirmation**

- **Always prompt me when TV format conflicts:** select this option to enable a warning message when you import a video clip whose TV format (NTSC/PAL) conflicts with that of the video clips already located in the storyboard.

- **Always prompt me when aspect ratio conflicts:** select this option to enable a warning message when you import a video clip whose aspect conflicts with that of the project.

- **Always prompt me when resetting adjustments:** select this option to enable a message asking you to confirm the resetting of all related modified adjustments back to the default values.

- **Always prompt me when new motion tracking masks are created:** select this option if you want CyberLink ColorDirector to provide you with some helpful tips every time you create a new motion tracking mask and are about to start tracking motion.

- **Always prompt me when modifying an existing motion tracking mask's shape:** select this option if you want CyberLink ColorDirector to provide you with some helpful tips when you adjust the shape of an existing motion tracking mask.

- **Always prompt me when trying to track motion again:** select this option if you want CyberLink ColorDirector to prompt you when the tracking of motion on a preexisting mask continues.

- **Always prompt me when a discontinued mask is created:** select this option if you want CyberLink ColorDirector to inform you when it creates a new motion tracking mask that is separate from the previously created motion tracking mask. This usually occurs because there is a gap of a few frames between the two motion tracking masks.

- **Always prompt me when ColorDirector stops tracking motion:** select this option if you want CyberLink ColorDirector to inform you when it stops tracking motion because the movement stopped.
always prompt me when entering non real-time preview mode: select this option if you want to be prompted every time you click the play button when non real-time preview mode is enabled.

always prompt me when the maximum number of masks are applied to a single clip: select this option if you want to be prompted when the maximum number of masks (five) are applied on an individual clip in the storyboard.

always prompt me when applying Pointdirector presets: select this option if you want to be prompted about the preset limitations every time you apply a Pointdirector preset in CyberLink Colordirector.

always prompt me when auto switching to non real-time preview mode during motion tracking: select this option if you want to be prompted when CyberLink Colordirector switches to non real-time preview mode to track mask motion.

always show the welcome dialog at startup/when new project created: select this option if you want CyberLink Colordirector to display the welcome dialog every time it launches or you create a new project.

directorzone preferences

in the preferences window, select the DirectorZone tab. the available options are as follows:

auto sign in

• auto sign in to DirectorZone when Colordirector is launched: select this option and then enter in your e-mail address and password to automatically sign in to DirectorZone when the program is opened. if you do not have a DirectorZone account, click on the Get an Account button.

privacy rules

• allow DirectorZone to gather editing information: select this option to allow DirectorZone to make a list of all the adjustments you made to the video clips when uploading them to social media web sites.

hardware acceleration preferences

in the preferences window, select the Hardware Acceleration tab. the available options are as follows:
Hardware acceleration

- **Enable hardware acceleration for video decoding**: if your computer supports NVIDIA CUDA/AMD Accelerated Parallel Processing/Intel Core Processor Family technology, select this option to use hardware acceleration to decode the video during the adjustment process and when previewing videos.

Produce Preferences

In the Preferences window, select the **Produce** tab. The available options are as follows:

**Produce**:

- **Reduce video blocky artifacts (Intel SSE4 optimized)**: select this option to improve the overall production quality of produced video, if your computer supports Intel SSE4 optimization.
Chapter 4:

ColorDirector Projects

When adjusting video clips in CyberLink ColorDirector, click the button to save your work as a project in the .cds file format, which is used exclusively by CyberLink ColorDirector.

**Note:** a CyberLink ColorDirector project (.cds) file essentially contains a list of the video clips in the storyboard panel, and a log of all the edits and adjustments you want to make to them. Project files do not include the video clips in them. If you want to save all your video production files in one place, use the Pack Project Materials function. To do this select, **File > Pack Project Materials** from the menu.

Use the options in the **File** menu to save, create new, or open existing projects in CyberLink ColorDirector.

**Note:** when you create a new project, CyberLink ColorDirector resets your library. If you want to create a new video production using the same media current in your library, select **File > New Workspace**.

The changes you make to your video clips in CyberLink ColorDirector do **not** affect the original videos you imported into the program. Since your edits are all saved in the project file, you can trim, edit, or remove clips, but still keep your original files on your hard drive, untouched. So let yourself get creative. If you end up changing things too drastically, you can always start over.

**Setting Project Aspect Ratio**

To set the aspect ratio for your project, select **4:3** or **16:9** from the aspect ratio drop down at the top of the window.

The video viewer window changes according to the aspect ratio you select.
Exporting Projects

You can export your CyberLink ColorDirector projects by packing all the materials in a folder on your computer's hard drive. Exported projects can then be imported into another computer running CyberLink ColorDirector.

To export your project, select **File > Pack Project Materials.**
Chapter 5: **Utilizing Keyframes**

By default when you are color correcting and adding color grading on video clips, the adjustments are applied to every single frame in the video, i.e. the entire video clip. However, you can use keyframes to only apply the adjustments on the frames of video you want modified, by defining the start and end points in the keyframe settings panel.

When in the Adjustment module, click 🕒 to open the keyframe settings panel.
You can use keyframes to define the start and end points of every type of adjustment in CyberLink ColorDirector, giving you full control over the process. Every adjustment item has keyframe controls for the timeline in the keyframe settings panel.

To use keyframes when making adjustments to video clips, do this:

1. Select the video clip in the storyboard and click the button to display the
keyframe settings panel.

2. Use the keyframe timeline to find the frame in your video clip where you want the adjustments to begin and end. See Keyframe Timeline for more information.

3. Add keyframes as required to mark where the adjustments begin and end. See Adding Keyframes for more information.

   Note: keyframes are also added to the keyframe timeline if you change the shape, position, or size of a regional adjustment mask.

4. Make adjustments to your video clip as required. See Making Video Adjustments for more information.
Keyframe Timeline

A custom keyframe timeline is generated for each video clip you import into the storyboard panel and is visible in the keyframe settings panel. In the below example, because the video clip is 10 seconds long, the keyframe timeline is also 10 seconds.

The timeline slider position corresponds to the position of the playback slider and the timecode display in the video viewer window.
Utilizing Keyframes

You can click and drag the edge of the keyframe settings panel to change the size of the timeline and the video in the preview window.
You can also zoom in on the keyframe timeline for a more precise placement of keyframes. To zoom in or out on the timeline, just click on the timeline ruler and drag it left or right, or use the slider at the bottom of the adjustment panel.

In the above example, the timeline is zoomed in to the frame level. Each line on the timeline ruler, now represents a frame of video.
Adding Keyframes

Any time you make a change to an adjustment item using one of the sliders, or change the size, shape, or position of a regional adjustment mask, a keyframe is automatically added to the keyframe timeline.

**Note:** even if you want an adjustment to be made on the entire duration of a video clip, CyberLink ColorDirector automatically adds a keyframe to the keyframe timeline.

To manually add keyframes to the keyframe timeline, do this:

1. Click on to open the keyframe settings panel.

2. Click on next to the adjustment item you want to change to add a keyframe at the beginning of the keyframe timeline.

3. Use the player controls to find the moment in your video clip where you want its properties to change (make adjustments).

4. Drag the sliders as required, making the adjustments to the video clip that you want to make. Note that a keyframe marker is added at that moment in timeline.
5. Right click on the first of the two keyframes to set how and when the adjustment/change is applied. See Setting Keyframe Behavior for more detailed information.

6. Repeat these steps to add more keyframes to the timeline, and for all the adjustments you want to make on the video clip, if required.

**Setting Keyframe Behavior**

If you have added two keyframes to the timeline and made the same adjustments, right click on the first keyframe to set the behavior, or when the adjusted properties will display in the video clip.

To set the behavior, right click on the first keyframe and then select one of the following keyframe behavior options:

- **Gradual Change from Current Keyframe**: select this option if you want the adjustment/change to be made gradually between the two keyframes. By the time the playback slider reaches the second keyframe, the adjustment/change is fully applied.
• **Instant Change at Next Keyframe:** select this option if you want the adjustment/change to be applied instantly once the playback slider has reached the second keyframe.

• **Instant Change at Current Keyframe:** select this option if you want the adjustment/change to be applied instantly once the playback slider has reached the first keyframe.

---

**Modifying and Removing Keyframes**

At any time you can modify the keyframes added, by selecting it in the timeline and changing the corresponding adjustments.

You can also do the following:

- to remove a keyframe, select it on the timeline and then click 
- click  to quickly jump to the previous keyframe, or  to jump to the next one.
CyberLink ColorDirector

- click on 🗑️ to remove and reset all keyframes on the selected timeline.
- right click on any keyframe on the keyframe timeline and then select **Reset to Default Value** to reset the adjustment back to the original setting. Note that the keyframe is not removed, the adjustment is just reset.
Making Video Adjustments

Chapter 6:

Click on the **Adjustment** button and then on the **Manual** tab to begin making adjustments to your video clips. Any adjustments you make are not auto-applied to the original video file. CyberLink ColorDirector keeps a log of all the adjustments you want to make, and then applies them to each video clip when it is rendered in the Production module. This leaves the original video clip untouched.

Adjustments can be made both globally (on the entire video frame, see [Global Adjustment Tools](#)) or regionally (on a specified area of the video frame only, see [Regional Adjustment Tools](#)). You can also apply adjustments to only the video frames you want to using keyframes. See [Utilizing Keyframes](#) for detailed information.

To make adjustments on videos in the library, do this:

1. Select the video clips in the library panel that you want to adjust, and then drag and drop them into the storyboard panel.

   **Note:** You can add more than one video clip to the storyboard panel for adjusting. However, all the video clips in the storyboard panel will be rendered into one longer video once produced in the Production window. If you do not want the video clips rendered together, you must add each of them to the storyboard separately, and then adjust and produce them one by one.

2. Click on the **Adjustment** button.

3. Select the specific video clip in the library that you want to adjust, and then drag and drop it into the storyboard panel.

4. Make all the adjustments on the video clip as required.

5. If required, add more video clips to the storyboard and make adjustments.

6. When you are done adjusting each video clip in the storyboard panel, click on the **Production** button to render them with the adjustments applied. See [Production](#) for more detailed information.
Converting Videos to Black and White

You can instantly convert a selected video to black and white.

To convert, select B&W at the top of the adjustment panel. To convert back, select Color.

*Note:* after you convert a video to black and white, the Black and White section of the adjustment panel is enabled. See Black and White for details on adjusting the lightness in black and white videos.

Regional Adjustment Tools

Use the regional adjustment tools if you want to modify only a specific area of the video frame in your selected video clip.

The following sections outline the features and functions available in the regional adjustment tools of CyberLink ColorDirector. To begin using a regional adjustment tool, just select it from the available icons.

Using a Selection Mask

A selection mask lets you select only the pixels in a video clip that you want to adjust. This allows you to select and adjust static objects in the video clip.

*Note:* the selection mask is ideal for adjusting areas of video in videos clips where the camera or objects in the area are motionless. If the camera is moving or objects move in the frame, try using a motion tracking mask. See Using a Motion Tracking Mask for more information.

Creating a Selection Mask

To create a selection mask and use it to make adjustments, do this:

*Note:* you can adjust multiple areas of the video using selection masks. See Using Multiple Selection Masks for more information.

1. Click 📸 to open the selection mask controls.
2. Use your mouse to manually select the area of the video frame you want to adjust. You do this by clicking around the outline of the area until an
enclosed section is selected.
Note: you can adjust the shape of the selection mask by clicking and dragging the nodes. Click a node to select it, and then press the Delete key on your keyboard to delete it. To add a new node, just hover your mouse over the line edge and click to add the required node.

3. Use the Feather slider to set the transition level between the area being selected and the pixels around the area. This slider is not enabled until a masked area has been defined on the video frame.

Note: CyberLink ColorDirector displays a mask color marker on the area you select. Right click on the mask color marker for more selection mask options.

5. Make the required adjustments to the selected part of the video frame using the regional adjustment options. See Regional Adjustment Options for a detailed description of all the available adjustments you can make.

Note: if required, click the button to invert the selected pixels. When selected, CyberLink ColorDirector will apply the adjustments to areas that were not selected. Click it again to revert the adjustments back to the pixels selected originally.

Adjusting Mask Position and Shape

If the selection mask you created appears off at any point during the duration of the video clip, you can easily adjust its position or shape.
Note: when you adjust the position or shape of a selection mask, CyberLink ColorDirector automatically adds a keyframe to the keyframe settings timeline to mark the change. See Utilizing Keyframes for more information on keyframes.

To adjust the selection mask position/shape, pause the video clip playback at the point when you want to make the adjustment and then do any of the following:

- click on a mask node to select it and then drag it to a new position.
- click on a mask node to select it, and then press the Delete key on your keyboard to delete it, if required.
- to add a new mask node, just hover your mouse over the line edge and click to add the required node.
- click on the mask color label and then drag the entire mask to a new position.
- right click on the mask color label for more options, including selecting all nodes, deleting the mask, resetting the adjustments, and more.

### Using Multiple Selection Masks

You can make up to five different selected adjustments on a video. When you select areas of the video and modify the adjustment options, a mask is auto created and labeled by color.

The mask label is visible in the **Mask** drop-down at the top of the selection mask tab.

To create a new adjustment mask, do this:

1. Select **New** from the **Mask** drop-down to create a new mask.
2. Use your mouse to manually select the area of the video frame you want to adjust, and then use the sliders to set the adjustments as required for the second adjustment.

3. CyberLink ColorDirector labels the mask with another color in the Mask dropdown.

4. CyberLink ColorDirector marks each mask on the video with the color label.

5. Click the color label to quickly select the mask, and view the selected areas (pixels) of the video where each of the adjustments was applied.

Using a Motion Tracking Mask

Use a motion tracking mask to adjust areas of the video that have moving objects, or when the camera moves in a video clip. When you apply the motion tracking mask on a set of pixels, CyberLink ColorDirector will auto track the pixels as they move through each video frame, adjusting the mask shape and applying the same adjustments to them.
Creating a Motion Tracking Mask

To create a motion tracking mask and use it to make adjustments, do this:

1. Click 🎥 to open the motion tracking mask controls.
2. Use the playback controls to find the first frame of video where the object or camera movement begins movement.
3. Set the mask options as follows:
   - **Brush/Eraser**: click on Brush and then use the mouse to select the pixels of the object or area you want to track. Click on Eraser if you make some errors using the brush and want to remove pixels that are selected.
   - **Size**: use the slider to set the size of the brush or eraser. You can also use the mouse scroll wheel to adjust the diameter of the brush/eraser.
   - **Feather**: use the slider to set the transition level between the area being selected and the pixels around the area.

   **Note**: the Feather slider is not enabled until a masked area has been defined on the video frame.

4. When you are done selecting all the pixels of the object for tracking, click on 🎥. CyberLink ColorDirector starts tracking the pixels as they move through
the frame. Click the button if you only want to track the movement for one frame of video.

**Note:** you can check the mask details in the keyframe settings panel. CyberLink ColorDirector adds a keyframe for the start and end points of the motion tracking to the mask’s keyframe timeline.

5. Click the button at any time if you want to stop the motion tracking. If you don’t click this button, CyberLink ColorDirector tracks the pixels until it can no longer detect movement or the pixels are no longer available, i.e. off screen or obstructed.

6. Once the motion tracking has stopped, make the required adjustments to the selected part of the video frame using the regional adjustment options. See **Regional Adjustment Options** for a detailed description of all the available adjustments you can make.

**Note:** if required, click the button to invert the selected pixels. When selected, CyberLink ColorDirector will apply the adjustments to areas that were not selected. Click it again to revert the adjustments back to the pixels selected originally.
Re-tracking a Motion Tracking Mask's Position and Shape

If the motion tracking mask you created appears off at any point during the duration of the video clip, you can easily adjust its position or shape, and then re-track the movement.

*Note:* when you adjust the re-track the position or shape of a motion tracking mask, CyberLink ColorDirector automatically adds a keyframe to the keyframe settings timeline to mark the change. See [Utilizing Keyframes](#) for more information on keyframes.

To re-track a motion tracking mask's position or shape, do this:

1. Pause the video clip playback at the point when you want to make the change to the mask.
2. Do either of the following:
   - use the brush or eraser to adjust the mask shape as required.
   - right click on the mask color label for more options, including deleting the mask, resetting the adjustments, and more.
3. Click ![re-track](#) to re-track the movement with the adjusted shape or position. Click ![frame](#) if you want to track the pixels one frame at a time.
4. CyberLink ColorDirector re-tracks the pixels within the mask from this point, adding a keyframe to the keyframe settings panel to note the change.

Using Multiple Motion Tracking Masks

You can make up to five different selected adjustments on a video. When you select areas of the video and modify the adjustment options, a mask is auto created and labeled by color.

The mask label is visible in the **Mask** drop-down at the top of the motion tracking mask tab.

To create a new adjustment mask, do this:
1. Select **New** from the **Mask** drop-down to create a new mask.

![Mask drop-down](image1.png)

2. Repeat the steps in **Creating a Motion Tracking Mask** to create the motion tracking mask, and then use the regional adjustment option sliders to set the adjustments as required for the second adjustment.

3. **CyberLink ColorDirector** labels the mask with another color in the **Mask** drop-down.

![Mask drop-down](image2.png)

4. **CyberLink ColorDirector** marks each mask on the video with the color label.

![Masked video](image3.png)

5. Click the color label to quickly select the mask, and view the selected areas (pixels) of the video where each of the adjustments was applied.
Using a Gradient Mask

Use the gradient mask to apply adjustments gradually across a large area of a video.

**Note:** the gradient mask is ideal for adjusting areas of video in video clips where the camera or objects in the area are motionless.

Adding a Gradient Mask

To add a gradient mask and use it to make adjustments, do this:

1. Click to open the gradient mask controls.
2. Click and drag on the video to set the gradient across a portion of the video. CyberLink ColorDirector displays a mask color on the area you apply.
3. Make the required adjustments to the selected part of the video frame using the regional adjustment options. See Regional Adjustment Options for a detailed description of all the available adjustments you can make.

Adjusting Mask Position and Size

If the gradient mask you created appears off at any point during the duration of the video clip, you can easily adjust its position or size.

Note: when you adjust the position or size of a gradient mask, CyberLink ColorDirector automatically adds a keyframe to the keyframe settings timeline to mark the change. See Utilizing Keyframes for more information on keyframes.

To adjust the gradient mask position/size, pause the video clip playback at the point when you want to make the adjustment and then do any of the following:

- click on a mask line and expand/contract the size, or rotate the mask if clicking on the middle line.
- click on the mask color label and then drag the entire mask to a new position.
- right click on the mask color label for more options, including deleting the mask, resetting the adjustments, and more.
Using Multiple Gradient Masks

You can use up to five gradient masks on a video in CyberLink ColorDirector. When you modify the adjustment options and use the gradient mask on the video, CyberLink ColorDirector auto creates a mask labeled by color.

The mask label is visible in the Mask drop-down at the top of the gradient mask tab.

To create a new gradient mask, do this:

1. Select New from the Mask drop-down to create a new mask.

2. Click and drag on the video to set the gradient across a different portion of the video.

3. Use the sliders to set the adjustments as required for the second gradient mask.

4. CyberLink ColorDirector labels the mask with another color in the Mask drop-down.

5. CyberLink ColorDirector marks each gradient mask on the video with the color label.
6. Click the color label to toggle the masks on and off, and view the areas of the video where the gradient was applied.
Regional Adjustment Options

When making regional adjustments with the selection mask, motion tracking mask, or a gradient mask, the following options are available to you.

**White Balance**

- **Temperature**: use to adjust the color temperature in the selected region of the video. A negative value applies a colder temperature, while a positive value applies an atmosphere that is warmer.
- **Tint**: use to adjust the color level in the selected region of the video.

**Tone**

- **Exposure**: use to adjust areas of the video that are over or underexposed. A negative value darkens overexposed areas, while a positive value lightens underexposed areas.
- **Brightness**: use to adjust the brightness in parts of the video.
- **Contrast**: use to adjust contrast, or the difference between light and dark areas of the video.
CyberLink ColorDirector

- **Clarity**: use to adjust the clarity of details in the video.
- **Vibrance**: use to make the colors in areas of a video brighter and more vivid, by enhancing the duller colors.
- **Saturation**: use to adjust the intensity of a color in certain areas of the video.

**Hue**

Use the **Hue** sliders to fine tune the shade or purity of a specific color in the selected region of the video. Use the sliders to adjust the eight color band ranges as required.

*Note*: if you converted the selected video to black and white, the Hue section is not available. The tool is not available when adjusting the Hue options with the regional adjustment tools.

**Saturation**

Click on **Saturation** to adjust the saturation of color in the selected region of the video. Dragging the sliders to right increases the amount of that color in the video, while dragging it to the left reduces it. If you drag the slider all the way to the left, you can completely remove a color from the selected section of the video frame.

*Note*: if you converted the selected video to black and white, the Saturation section is not available. The tool is not available when adjusting the Saturation options with the regional adjustment tools.

**Lightness**

Click on **Lightness** to adjust color brightness in the selected region of the video. For each of the eight colors listed, you can adjust how light or dark the specific color is.

*Note*: if you converted the selected video to black and white, the Lightness section is not available. The tool is not available when adjusting the Lightness options with the regional adjustment tools.
Color Replacement

In the Color Replacement section, you can replace a color in the selected region of the video with a completely different color.

**Note:** if you converted the selected video to black and white, the Color Replacement section is not available.

To replace a color the selected region of the video, do this:

1. Click the button and then use the eye dropper to select the color in the video you want to replace. You can also click the box in the Original Color section and choose the color you want to replace in the color palette window.

2. In the New Color section, click on . In the Color window choose the color you want to replace the original with and then click OK.

3. Use the Tolerance slider to set the strength and amount of the replaced color.
Global Adjustment Tools

Use the global adjustment tools to modify the entire frame of a video clip. The following sections outline the features and functions available in the global adjustment tools of CyberLink ColorDirector.

White Balance

Use white balance for color correction or you can use it to adjust the color temperature of a video to create a specific atmosphere. A warmer color shifts light toward the yellows and reds; a colder color shifts light toward the blues and greens.

To adjust the atmosphere of a video using white balance, do this:

1. Drag the Temperature slider to adjust the color temperature in the video. A negative value applies a colder temperature, while a positive value applies an atmosphere that is warmer.
2. Drag the Tint slider to adjust the color level of in the video.

To use white balance to color correct a video, click and then use the eye dropper to select a pixel in the video that you believe should be grey.

![Eye dropper with RGB values]

CyberLink ColorDirector auto corrects the color in the video.

Tone

In this section of the adjustment panel, the sliders available adjust the tone of the entire video, while the Tinge sliders let you modify the clarity, vibrancy, and saturation levels.

To adjust the tonal level of your videos, do this:

1. Manually adjust color tone using the available sliders as follows:
   - **Exposure**: use on videos that are over or underexposed. A negative value darkens the all the colors in the video, while a positive value lightens them.
• **Contrast**: use to adjust contrast, or the difference between light and dark areas of the video.

• **Brightest**: use to brighten/darken the colors in the video that are close to whites. Darkening the lighter colors can enhance their contrast and make highlights stand out more. Drag the slider left to darken, reducing the clipping in highlights. Drag it right to brighten and clip the colors that are close to white.

• **Bright**: is applied to areas of videos that are overexposed, which can recover detail in the highlights and brighter areas. Drag the slider left to recuperate lost detail in highlights by darkening them. Drag it right to brighten the video without clipping the brighter areas.

• **Midtone**: use to adjust the overall brightness of the video by changing the midtone colors only. Drag the slider left to darken, or right to brighten.

• **Dark**: can be used to help enhance detail in dark sections of the video by brightening shadows and underexposed areas. Drag the slider left to darken the video without clipping the shadows. Drag it right to recuperate lost detail in shadows by brightening them.

• **Darkest**: use to brighten/darken the colors in the video that are close to blacks. Brightening the darker colors can enhance their contrast and make shadows stand out more. Drag the slider left to darken and clip the dark colors. Drag it right to brighten and reduce clipping in shadows.

2. Manually adjust the sliders to adjust the video tinge as follows:

• **Clarity**: use to adjust video clarity. Dragging the slider to the right makes the video appear crisper, while to the left makes it appear more "dreamy".

• **Vibrance**: use to make the colors in a video brighter and more vivid, by enhancing the duller colors.

• **Saturation**: use to adjust the saturation of color in a video. A negative value moves the colors towards black and white, while a positive value increases the overall intensity of color in the video.

**Hue**

Click on **Hue** to fine tune the shade or purity of a specific color the video. Use the sliders to adjust the eight color band ranges as required.
You can also click on \[\text{?}\] and then click and (while holding the mouse button down) drag on a specific color in the video. Drag the mouse up to increase the hue, or down to decrease it.

**Saturation**

Click on **Saturation** to adjust the saturation of color in the video. Dragging the sliders to right increases the amount of that color in the video, while dragging it to the left reduces it. If you drag the slider all the way to the left, you can completely remove a color from the video.

**Note:** if you converted the selected video to black and white, the Saturation section is not available, and is replaced by the Black and White section. See Black and White for details on adjusting the lightness in black and white videos.

Use \[\text{?}\] to adjust the color saturation by clicking on a color in the video and then dragging the mouse up or down. While holding the mouse button down, dragging the mouse up increases the color saturation. Dragging the mouse down decreases it.

**Lightness**

Click on **Lightness** to adjust color brightness. For each of the eight colors listed, you can adjust how light or dark the specific color is.

**Note:** if you converted the selected video to black and white, the Lightness section is not available, and is replaced by the Black and White section. See Black and White for details on adjusting the lightness in black and white videos.

Use \[\text{?}\] to adjust the lightness of a specific color in the video. Just click on the color and drag the mouse up to increase the brightness, or drag it down to decrease, making the color darker.

**Black and White**

When you convert videos to black and white, this section becomes enabled, replacing the Hue, Saturation, and Lightness sections. In it you can adjust the overall video image lightness on the converted clips.
Use the **Lightness** sliders to adjust the brightness of the original colors, which are now black and white.

**Color Replacement**

In the Color Replacement section, you can replace a color in the video with a completely different color.

*Note: if you converted the selected video to black and white, the Color Replacement section is not available.*

To replace a color in the selected video clip, do this:

1. Click the **button and then use the eye dropper to select the color in the video you want to replace. You can also click the box in the Original Color section and choose the color you want to replace in the color palette window.

2. In the New Color section, click on **. In the Color window choose the color you want to replace the original with and then click **OK**.

3. Use the **Tolerance** slider to set the strength and amount of the replaced color.
Chapter 7:

Using Adjustment Presets

Adjustment presets are a saved set of adjustments that you can apply to your video clips. You can also download and import presets created by other users, or save your own to use on other video clips or share them by uploading to DirectorZone.

Click on the Presets tab to display the available adjustment presets.

Downloading Presets from DirectorZone

CyberLink ColorDirector supplies you with some custom adjustment presets that you can use on your videos. On the Presets tab, these default adjustment presets are available in the Default Presets section.

To download additional adjustment presets from DirectorZone, do this:

1. Click on Download more from DirectorZone link. CyberLink ColorDirector launches DirectorZone in your default web browser.

2. You must first sign in to DirectorZone to download templates. If you don't have an account, click the Create Account link at the top of the page to get one for free.

3. Select the ColorDirector tab to display all the available adjustment presets you can download.

4. Find a preset you want to download, and then click the Download link underneath it.

5. Click Download again.

6. Save the template to your computer. Find the location on your computer where you saved the preset file, and then double-click on it to install it in the Presets window.
Saving Custom Presets

You can save all the adjustments you made on a video into a custom preset, so that you can use them on other video clips.

To save a custom adjustment preset, do this:

1. Click on \+ when on the Presets tab, or at the bottom of the Manual tab click on Create.
2. In the New Preset window, enter the following information:
   - **Preset name**: enter a custom name for the new preset.
   - **Save in**: select which preset folder on the Presets tab you want to save the preset in. Select New Folder if you want to save the custom preset in a new folder.
3. Select or deselect any adjustment types as required. This allows you to customize the adjustment if required.
   
   **Note**: by default, all adjustment types are selected.
4. Click the Save button.
   
   **Note**: before saving the preset, click the Share button if you want to upload it to DirectorZone. See Uploading Presets to DirectorZone for more information on uploading presets to DirectorZone.

Applying Presets on Videos

You can apply any of the adjustments presets on the Presets tab on video clips in the storyboard.

To apply adjustment presets on videos, do this:

1. Select the video clips that you want to apply presets to in the storyboard panel and then click on the Presets tab.
2. Hover your mouse over each available preset to preview the current video with the adjustment applied.
3. Click on the adjustment preset you want to use to apply it.
Uploading Presets to DirectorZone

You can share the custom presets you create by uploading them to DirectorZone.

To upload custom presets to DirectorZone, do this:

1. Select the preset that you want to upload and then click.
2. Follow the detailed steps in the Upload to DirectorZone wizard to complete the upload process.
3. Click Close once the upload is complete.

Exporting/Import Presets

You can export your adjustment presets for import and use on another computer.

To export an adjustment preset, do this:

1. Right-click on a preset and then select Export.
2. Enter a file name for the preset, and then select the location where you want to export it.
3. Click Save. CyberLink ColorDirector saves the preset in the .cdadj file format.

To import an adjustment preset, do this:

Note: you can import adjustment presets in the .pdadj and .cdadj file formats via this import method. If you are trying to import an adjustment preset in either of these formats that you downloaded from DirectorZone, just double click on it.

1. Within the Downloaded Preset or My Created Presets section, click on and then select Import.
2. Browse to location of the preset file and then select Open to complete the import.
CyberLink ColorDirector
Chapter 8:

Turning Adjustments On/Off

You can turn off a set of adjustments applied to a video instantly. This allows you to reset the one type of adjustments, instead of resetting all the adjustments by clicking Reset.

To do this, just deselect the check box associated to the applied adjustments.

At any time you can turn the adjustments back on by re-selecting the check box.

*Note: you can also click the button if you would like to reset a set of adjustments back to the default values.*
Chapter 9: Production

When you make adjustments to videos, the last step is to produce them, or render them with the edits and adjustments applied. CyberLink ColorDirector keeps a log of all the edits and adjustments you want to make to each video clip, and producing it applies all these adjustments and creates a new video file for you.

If there are multiple video clips in your project's storyboard panel, the production feature renders all the clips into one longer video movie file. You can render them in a variety of video file formats.

| Note: if you have CyberLink PowerDirector 11 installed on your computer, you can also select File > Export Project to PowerDirector from the menu to quickly send all the individual adjusted video clips in the storyboard directly to the PowerDirector timeline. |

To produce your video clips, click the Production button to open the Production module.

Producing Video Files

You can produce your videos and render them as video files in the .MP4, .MTS, .MPG, or .WMV format.

To produce a video, do this:

1. Click the Production button, and then on the Video File tab if necessary.
2. Specify the Output folder, or the location where the produced video file is saved. Click if you want to select another output folder or change the name of the produced file.
3. Select an output format (.MP4, .M2TS, .MPG, .WMV) by selecting the corresponding button.
4. Select the Profile name/quality you want to use to create the file. If you are producing the video in the .WMV format, select the Profile type. This selection determines the video resolution, file size, and overall quality of the outputted file. See Customizing Profiles for more information.

| Note: if you created a custom profile, it is available in Profile name/quality drop down when you select Custom in the Profile type drop-down. |
5. Select the **Country/Video format (NTSC or PAL)** for your video. This format should correspond to the region in which you plan to play your video.

6. Configure the production options as required. See **Configuring Production Options** for more information.

7. Click **Start** to begin. CyberLink ColorDirector proceeds to produce and create the video file.

## Customizing Profiles

After you select a file format for your outputted file, depending on the format you selected, there may be quality settings you can customize in the profiles section. These quality settings are called profiles, and can consist of a video file's resolution, bitrate compression, audio compression type, and more.

In the production options section you can:

- click ![+] to create your own custom video profile from scratch.

- select an existing profile, and then click ![/ ] to edit it to fit your requirements.

- click ![ ] to view a profile's details, or ![ ] to delete a custom profile you created previously.

Before you output your production, you may want to create a new quality profile, edit an existing one, or select a different existing profile, and other options from one of the available drop-downs in the production options section.

## Configuring Production Options

Before you begin producing your file, you can select from the following production options:

- **Hardware video encoding**: select this option to reduce production time. The **Hardware video encoding** option is only enabled if your computer supports hardware acceleration (NVIDIA graphics card that supports CUDA, an AMD graphics card that supports AMD Accelerated Parallel Processing, or a computer with Intel Core Processor Family technology), and you are outputting in a file format that supports it (H.264 and MPEG-4).

- **Intel Quick Sync Video**: if your computer supports Intel Quick Sync Video, and
you are outputting in either the H.264, MPEG-4, or MPEG-2 format, this option is available. Select it to reduce production time.

- **Dolby Digital 5.1**: select this option if you want to include Dolby Digital 5.1 audio in your produced video file.

- **x.v.Color**: x.v.Color is a color system that can display a wider color range than usual. CyberLink ColorDirector can generate an x.v.Color-compliant stream, which is backward compatible with RGB displays, while offering the opportunity to achieve better visual quality if your playback environment is x.v.Color ready.

- **Enable preview during production**: select this option to preview your video during production. Selecting this option will increase the time required to produce your video file.

## Sharing Videos

You can share videos in your library with others by uploading them to YouTube. To do this, click on the **Production** button and then select the **Online** tab.

## Uploading Videos to YouTube

To upload your video to YouTube, do this:

---

**Note**: if the size/length of the your video exceeds the maximum allowed, CyberLink ColorDirector will separate the video into smaller/shorter videos, upload these videos, and then create a playlist for you on YouTube.

1. Specify the **Output folder**, or the location where the produced video file that will be uploaded is saved. Click 📦 if you want to select another output folder or change the name of the produced file.

2. Click the **YouTube Videos** button.

3. Select the desired quality of your video from the **Profile type** drop-down. The quality you select will result in the corresponding quality option being available after the video is fully processed on YouTube.

   **Note**: the quality option available on YouTube is also dependent on the original captured video quality and the bandwidth of the user who is watching the video.

4. Enter a **Title** and **Description** for your video in the fields provided. The text you enter is included on YouTube once uploaded. Also select one of the **Video categories** and enter in some keyword **Tags** that users can search for to
find your video.

5. Set whether you want the video to be **Public** or **Private** once it is uploaded to YouTube.

**Note:** sign in to DirectorZone and then select **Share in CyberLink DirectorZone Video Gallery** if you want to show others how you adjusted the clips in your video production. When selected, an animated version of your project's storyboard displays, along with your uploaded video, on DirectorZone.

6. Configure the production options as required. See **Configuring Production Options** for more information.

7. Click **Start** to begin.

8. Click **Authorize** and then grant CyberLink ColorDirector permission to upload videos to your YouTube account by following the steps in the YouTube Authorization windows.

9. CyberLink ColorDirector proceeds to produce and upload the video file. Click **Close** when done to return to the program.

### Configuring Production Options

Before you begin producing, you can select the following production options:

- **Hardware video encoding**: this option is only enabled if your computer supports hardware acceleration (an AMD graphics card that supports AMD Accelerated Parallel Processing), and you are outputting in a file format that supports it.

- **Enable preview during production**: select this option to preview your movie during production. Selecting this option will increase the time required to produce your file.
Chapter 10:

ColorDirector Hotkeys

The following is a list of the hotkeys available in CyberLink ColorDirector for your convenience:

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Description</th>
<th>Module Available</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File/Project Features</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>Create new project.</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+Shift+W</td>
<td>New workspace.</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Open existing project.</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save current project.</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+Shift+S</td>
<td>Save as a new project.</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Pack project materials.</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+Q</td>
<td>Import video files.</td>
<td>Library</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Import video folder.</td>
<td>Library</td>
</tr>
<tr>
<td>Alt+F4</td>
<td>Exit CyberLink ColorDirector</td>
<td>All</td>
</tr>
<tr>
<td>Alt+C</td>
<td>Open CyberLink ColorDirector preferences window.</td>
<td>All</td>
</tr>
<tr>
<td><strong>Workspace</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alt+F9</td>
<td>Go to Library module.</td>
<td>Adjustment, Production</td>
</tr>
<tr>
<td>Alt+F10</td>
<td>Go to Adjustment module.</td>
<td>Library, Production</td>
</tr>
<tr>
<td>Alt+F11</td>
<td>Go to Production module.</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>F6</td>
<td>Switch to viewer &amp; storyboard mode in video viewer window.</td>
<td>All</td>
</tr>
<tr>
<td>F7</td>
<td>Switch to viewer only mode in video viewer window.</td>
<td>All</td>
</tr>
<tr>
<td>Alt+Z</td>
<td>Open video zoom list view.</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>F</td>
<td>Go to full screen</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Alt+1</td>
<td>Toggle show one mode on/off.</td>
<td>Adjustment</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Alt+2</td>
<td>Toggle compare before/after mode on/off.</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Alt+3</td>
<td>Toggle split left/right mode on/off.</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Alt+4</td>
<td>Toggle top/bottom mode on/off.</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Alt+5</td>
<td>Toggle split top/bottom mode on/off.</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Alt+B</td>
<td>Set video viewer background color.</td>
<td>All</td>
</tr>
<tr>
<td>F1</td>
<td>Open CyberLink ColorDirector help.</td>
<td>All</td>
</tr>
</tbody>
</table>

**Operational**

<table>
<thead>
<tr>
<th>Ctrl+Z</th>
<th>Undo last adjustment setting.</th>
<th>Library, Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Y</td>
<td>Redo last adjustment setting.</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Ctrl+R</td>
<td>Reset adjustments to default settings.</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Select all videos in the storyboard panel.</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Deselect all videos in the storyboard panel.</td>
<td>All</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the selected videos from the library/storyboard.</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Ctrl+T</td>
<td>Split the select video clip and the current location.</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Ctrl+Alt+T</td>
<td>Open the Trim window.</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Home</td>
<td>Go to beginning of video clip.</td>
<td>All</td>
</tr>
<tr>
<td>End</td>
<td>Go to end of video clip.</td>
<td>All</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>Go to previous clip/scene.</td>
<td>All</td>
</tr>
<tr>
<td>Right Arrow</td>
<td>Go to next clip/scene.</td>
<td>All</td>
</tr>
<tr>
<td>Shortcut</td>
<td>Action</td>
<td>Context</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Alt+Mouse Wheel</td>
<td>Switch to and resize eraser when using the motion tracking mask brush.</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Ctrl+Left</td>
<td>-1 unit on the selected tool slider.</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Ctrl+Right</td>
<td>+1 unit on the selected tool slider.</td>
<td>Adjustment</td>
</tr>
<tr>
<td>Ctrl+Alt+D</td>
<td>Open the Detect Scene window.</td>
<td>Library/Adjustment</td>
</tr>
<tr>
<td>Space Bar</td>
<td>Play/Pause video playback.</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+/</td>
<td>Stop video playback.</td>
<td>All</td>
</tr>
<tr>
<td>Up Arrow</td>
<td>Scroll up when mouse over adjustment slider.</td>
<td>All</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Scroll down when mouse over adjustment slider.</td>
<td>All</td>
</tr>
<tr>
<td>,</td>
<td>Go to previous frame.</td>
<td>All</td>
</tr>
<tr>
<td>.</td>
<td>Go to next frame.</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Fast forward video playback.</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>Access video volume control.</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+Backspace</td>
<td>Toggle mute on/off</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl+Mouse Wheel Up</td>
<td>Zoom in on video viewer window.</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>Ctrl+Mouse Wheel Down</td>
<td>Zoom out on video viewer window.</td>
<td>Library, Adjustment</td>
</tr>
<tr>
<td>&lt;</td>
<td>Zoom in on keyframe timeline ruler.</td>
<td>Adjustment</td>
</tr>
<tr>
<td>&gt;</td>
<td>Zoom out on keyframe timeline ruler.</td>
<td>Adjustment</td>
</tr>
</tbody>
</table>

**Shortcuts**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
<th>Context</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+F</td>
<td>Open [File] menu.</td>
<td>All</td>
</tr>
<tr>
<td>Alt+E</td>
<td>Open [Edit] menu.</td>
<td>All</td>
</tr>
<tr>
<td>Alt+V</td>
<td>Open [Video] menu.</td>
<td>All</td>
</tr>
<tr>
<td>Key Combination</td>
<td>Description</td>
<td>Platform</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Alt+I</td>
<td>Open [View] menu.</td>
<td>All</td>
</tr>
<tr>
<td>Alt+H</td>
<td>Open [Help] menu.</td>
<td>All</td>
</tr>
</tbody>
</table>
Chapter 11:

Technical Support

This chapter contains technical support information. It includes all the information to find the answers you need to assist you. You may also find answers quickly by contacting your local distributor/dealer.

Before Contacting Technical Support

Please take advantage of one of CyberLink’s free technical support options:

- consult the user’s guide or the online help installed with your program.
- refer to the Knowledge Base in the Support section of the CyberLink web site.

http://www.cyberlink.com/support/index.html

The FAQs may have information and helpful hints that are more current than the User Guide and online help.

When contacting technical support by email or phone, please have the following information ready:

- registered **product key** (your product key can be found on the software disc envelope, the box cover, or in the e-mail received after you purchased CyberLink products on the CyberLink store).
- the product name, version and build number, which generally can be found by clicking on the product name image on the user interface.
- the version of Windows installed on your system.
- hardware devices on your system (capture card, sound card, VGA card) and their specifications.
- the wording of any warning messages that were displayed (You may want to write this down or take a screen capture).
- a detailed description of the problem and under what circumstances it occurred.
Web Support

Solutions to your problems are available 24 hours a day at no cost on the CyberLink web sites:

Note: you must first register as a member before using CyberLink web support.

CyberLink provides a wide range of web support options, including FAQs, in the following languages:

<table>
<thead>
<tr>
<th>Language</th>
<th>Web Support URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td><a href="http://www.cyberlink.com/support/index.html">http://www.cyberlink.com/support/index.html</a></td>
</tr>
<tr>
<td>Spanish</td>
<td><a href="http://es.cyberlink.com/support/index.html">http://es.cyberlink.com/support/index.html</a></td>
</tr>
<tr>
<td>German</td>
<td><a href="http://de.cyberlink.com/support/index.html">http://de.cyberlink.com/support/index.html</a></td>
</tr>
<tr>
<td>Italian</td>
<td><a href="http://it.cyberlink.com/support/index.html">http://it.cyberlink.com/support/index.html</a></td>
</tr>
</tbody>
</table>

Note: CyberLink’s user community forum is only available in English and German.
Index

A
Adjustments
  black and white 36
  global tools 52
  hue 53
  lightness 54
  presets 57
  regional tools 36
  resetting 61
  saturation 54
  tone 52
  turning off/on 61
  white balance 52
Aspect ratio
  setting 23

B
Black and white 36
Brightness 49

C
Clarity 50, 53
Color replacement 51, 55
Contrast 49, 53
Controls
  motion tracking 19

D
DirectorZone
  downloading from 57
  overview 2
  preferences 21
  uploading to 59
Download
  presets 57
  downloading 57

E
Effects
  keyframes 31
Export 63
  projects 24
Exposure 49, 52

F
Feather 38
File handling
  preferences 21
Fit 17
Full screen 17

G
Global adjustment tools 52
Gradual 32
**Hotkeys** 67
**Hue** 53

**Import**
- videos 5
- Instant 32
- Invert 38, 42

**Keyframes**
- adding 31
- behavior 32
- settings 25
  - settings panel 10

**Library**
- view 9
- Lightness 54
  - black and white 55

**Masks**
- inverting 38, 42
- Metadata 9

**Mix** 54
**Motion tracking controls** 19

**Options** 18

**PowerDirector** 63
**PowerDVD**
- technical support 71
**Preferences** 19
- Presets 57
  - uploading 59
- Produce
  - videos 63
- Projects 23
  - exporting 24

**Quality** 18

**Real-time preview** 18
**Regional adjustment tools** 36
**Reset** 61

**Saturation** 50, 53, 54
<table>
<thead>
<tr>
<th><strong>Save</strong></th>
<th>resolution 18</th>
</tr>
</thead>
<tbody>
<tr>
<td>projects 23</td>
<td>sharing 65</td>
</tr>
<tr>
<td><strong>Share</strong></td>
<td>supported formats 5</td>
</tr>
<tr>
<td>65</td>
<td>zooming 17</td>
</tr>
<tr>
<td><strong>Supported formats</strong></td>
<td>View mode 17</td>
</tr>
<tr>
<td>5</td>
<td>Viewer</td>
</tr>
<tr>
<td><strong>System requirements</strong></td>
<td>zooming 17</td>
</tr>
<tr>
<td>3</td>
<td><strong>T</strong></td>
</tr>
<tr>
<td><strong>Technical support</strong></td>
<td>Web support 72</td>
</tr>
<tr>
<td>71</td>
<td>White balance 52</td>
</tr>
<tr>
<td><strong>Temp</strong></td>
<td>Workspace</td>
</tr>
<tr>
<td>52</td>
<td>creating new 23</td>
</tr>
<tr>
<td><strong>Tint</strong></td>
<td><strong>W</strong></td>
</tr>
<tr>
<td>52</td>
<td><strong>Zoom</strong></td>
</tr>
<tr>
<td><strong>Tone</strong></td>
<td>17</td>
</tr>
<tr>
<td>52</td>
<td><strong>W</strong></td>
</tr>
<tr>
<td><strong>Turn off/on</strong></td>
<td>Upload</td>
</tr>
<tr>
<td>61</td>
<td>presets 59</td>
</tr>
<tr>
<td><strong>U</strong></td>
<td><strong>V</strong></td>
</tr>
<tr>
<td><strong>Upload</strong></td>
<td>Vibrance 50, 53</td>
</tr>
<tr>
<td><strong>V</strong></td>
<td>Video browser</td>
</tr>
<tr>
<td></td>
<td>view mode 17</td>
</tr>
<tr>
<td><strong>Vad</strong></td>
<td>Videos</td>
</tr>
<tr>
<td></td>
<td>black and white 36</td>
</tr>
<tr>
<td></td>
<td>color replacement 51, 55</td>
</tr>
<tr>
<td></td>
<td>importing 5</td>
</tr>
<tr>
<td></td>
<td>information 9</td>
</tr>
<tr>
<td></td>
<td>keyframes 25</td>
</tr>
<tr>
<td></td>
<td>playing back 18</td>
</tr>
<tr>
<td></td>
<td>producing 63</td>
</tr>
<tr>
<td></td>
<td>quality 18</td>
</tr>
<tr>
<td><strong>Workspace</strong></td>
<td>creating new 23</td>
</tr>
<tr>
<td><strong>Zoom</strong></td>
<td>Web support 72</td>
</tr>
<tr>
<td>17</td>
<td>White balance 52</td>
</tr>
<tr>
<td><strong>Zooming</strong></td>
<td>Workspace</td>
</tr>
<tr>
<td>17</td>
<td>creating new 23</td>
</tr>
</tbody>
</table>